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[bookmark: _Introduction][bookmark: _Toc122981741]Introduction
1.1 [bookmark: _Toc122981742]Overview of Data Fusion tool
Data Fusion (DF) is an innovative tool to derive spatial and temporal fields based on a series of data fusion methods commonly applied in health and economic benefit assessments (e.g., Environmental Benefits Mapping and Analysis Program – BenMAP) and air quality attainment assessments (e.g., Software for Model Attainment Test – SMAT) tools. The objective of this DF tool is to provide scientists and policymakers a user-friendly framework for creating desired spatial and temporal fields from existing air quality monitoring and model data and evaluating the results of fused spatial and temporal fields. The spatial and temporal field can be annual, quarterly, monthly, or daily distribution of predicted concentrations on the entire domain or sub-domain. 
This standalone DF tool currently implements five built-in data fusion techniques: 
(1) [bookmark: _Hlk43371931]Voronoi Neighbor Averaging (VNA)
(2) Enhanced Voronoi Averaging (eVNA) 
(3) Downscaler (DS)
(4) Weighting VNA (wVNA) 
(5) Nearest Site (NS) 
The DF tool has an easy-to-use graphical user interface (GUI) to allow users to flexibly create spatial and temporal data fields, conduct cross-validation (including Multi-fold, Leave-one-out, and Leave-group-out cross-evaluation methods), and provide visualization analysis capabilities (e.g., map, GIS and chart, etc.), as well as contains a built-in long-term ambient monitoring network database for PM2.5 and its component species and ozone.
The DF tool includes five key modules currently:
(1) Data input module
(2) Data fusion technique module
(3) Spatial and temporal option module
(4) Cross validation module
(5) Data viewer module
The detailed description of each module can refer to later chapters.
This document provides instructions on how to use DF to conduct data fusion analysis for PM2.5 and O3 with the following chapters:
· Chapter 1. DF introduction and installation
· Chapter 2. Quick Start
· Chapter 3. Functional Framework of Data Fusion
· Chapter 4. PM2.5 Data Fusion Analysis Details
· Chapter 5. Ozone Data Fusion Analysis Details
· [bookmark: _Evaluation_Principle_of][bookmark: _Hlk523495534]Chapter 6. Data Viewer for analyzing results
1.2 [bookmark: _Computer_Requirements_and][bookmark: _Computer_Requirements][bookmark: _Toc122981743]Computer Requirements
Data Fusion requires a computer with:
a) Net Framework Version 4.0 or higher. 
b) 32-bit or 64-bit Windows 7/Windows 8/Windows 10.
c) 2 GB RAM or greater.
d) 6 GB free disk space or greater.
1.3 [bookmark: _Toc439061747][bookmark: _Toc438541458][bookmark: _Toc122981744]Install/Uninstall Data Fusion
1.3.1 [bookmark: _Toc439061748][bookmark: _Toc438541459][bookmark: _Toc122981745]Install Data Fusion
· Download Data Fusion Software Package from the ABaCAS website:
(1) ABaCAS website: 
http://abacas.see.scut.edu.cn/tools/ 
· [bookmark: _Hlk43994439]Double click the package (e.g., Data Fusion v2.4 setup.exe) to install the program, it will appear the following window (Figure 1).
[image: ]
[bookmark: _Ref445828077][bookmark: _Toc122981777][bookmark: _Toc37923795]Figure 1. Setup Window
· Click the “Next” button, users can customize the destination folder to install as shown in Figure 2.
[image: ]
[bookmark: _Ref438996860][bookmark: _Toc37923796][bookmark: _Toc122981778]Figure 2. Choose Install Path
· Click the “Next” button, it will show the “Ready to Install the Program” window as shown in Figure 3.
[image: ]
[bookmark: _Ref438996876][bookmark: _Toc37923797][bookmark: _Toc122981779]Figure 3. Ready to Install
· Click the “Install” button, then the Data Fusion will start installing.
[image: ]
[bookmark: _Toc37923798][bookmark: _Toc122981780]Figure 4. Installation Process
· Click the “Finish” button and complete installation.
[image: ]
[bookmark: _Toc37923799][bookmark: _Toc122981781]Figure 5. Complete Installation
1.3.2 [bookmark: _Toc438541460][bookmark: _Toc439061749][bookmark: _Toc122981746]Uninstall Data Fusion
· Go to Control Panel.
· Select Data Fusion and click “Change/Remove”, the following window will appear.
[image: ]
[bookmark: _Toc37923800][bookmark: _Toc122981782]Figure 6. Uninstall Data Fusion
After a few seconds, the uninstallation process will finish.
1.4 [bookmark: _Toc439061750][bookmark: _Toc122981747][bookmark: _Toc438541461]Contacts for Comments and Questions
For comments and questions, please contact:
(1) [bookmark: _Hlk43994636]The Center for Community Modeling and Analyses System (CMAS) at the University of North Carolina at Chapel Hill via e-mail at cmas@unc.edu.
[bookmark: _Evaluation_Principle_of_1][bookmark: _Toc122981748][bookmark: _Toc45225391]Quick Start 
This chapter provides the steps required to run DF for PM and Ozone analyses. The Quick Start will use EPA’s data set to demonstrate how to run each of the DF analysis modules. These steps will use the default settings and do not describe the configuration settings for each analysis. For details of the configuration settings for the individual DF modules, refer to the User’s Manual chapter for each module. 
[bookmark: _Toc122981749]Start the Data Fusion
Double click the Data Fusion icon on the desktop or the executable file (Data Fusion.exe) under the installation path to start the program.
·  The Start Page window will appear on your screen after starting the program, as shown in Figure 7.
[image: ]
[bookmark: _Ref512329720][bookmark: _Ref512329713][bookmark: _Toc37923802][bookmark: _Toc122981783]Figure 7. Start Page of Data Fusion
[bookmark: _Toc122981750]Load existing project
· Click Open in the File pull-down menu item on the start page, select the project file (*.proj) of interest to open, then it can be loaded into the DF Data Viewer to probe the results. All project files are stored in your computer’s document directory (C:\Users\ … \Documents\My DataFusion Files\Result\Project) by default. Users can select a default project named test_default.
· After opening a project, the program will jump to the data viewer module, as shown in Figure 8.
[image: ]
[bookmark: _Ref512330323][bookmark: _Toc37923803][bookmark: _Toc122981784]Figure 8. Open a previous project
· After the selected project is loaded, users are also allowed to view the configuration options of this project by clicking the project name with a blue hyperlinked text in the top of output files. Analyzing existing projects can refer to the details of Chapter 6 below. Users are allowed to return to the Map view by clicking the Viewer tab.
[bookmark: _Toc122981751][bookmark: _Toc439061755][bookmark: _Toc438541466]Create a new project
·  Click New Project in the File pull-down menu item on the start page. The program will reset all settings and jump to the parameter configuration module, as shown in Figure 9.
[image: ]
[bookmark: _Ref512331844][bookmark: _Toc37923804][bookmark: _Toc122981785]Figure 9. Create a new project
·  Configure the parameters of each step, then save and run the new project. For more information, please refer to the details of Chapter 4 (PM2.5 data fusion analysis) and Chapter 5 (Ozone data fusion analysis). 
[bookmark: _Toc112399703][bookmark: _Toc122981752][bookmark: _Toc476654831][bookmark: _Toc476653930][bookmark: _Toc476654453][bookmark: _Toc45225393][bookmark: _Toc122981753]Running Data Fusion Tool in Batch Mode
Configuration files (*.cfg) are used to define the settings for analyses in Data Fusion Tool.  There are two ways to export/edit a Configuration File. 
1. Open a pre-run project, user can modify the analysis options and save current configuration into a single file by clicking the button File – Save Configuration file (*.cfg).
[image: ]
[bookmark: _Toc122981786]Figure 10. Save Configuration File
1. Open a pre-run project, click “Config/Batch”. Under this page, user can view/edit the project settings and export as *.cfg file.
[image: ]
[bookmark: _Toc122981787]Figure 11. View/Edit Configuration File
Data Fusion Configuration Files can be concatenated in a Windows batch script to automatically run multiple Data Fusion analyses in sequence. A Data Fusion Configuration File (*.cfg) stores the configuration options for one Data Fusion Analysis (i.e., PM2.5, Ozone). Multiple Configuration Files can be used to define a suite of analyses to run at once through a batch script.  The Configuration Files are created and saved automatically when setting up an analysis in Data Fusion Tool. They can be edited either through the Data Viewer or using a text editor outside of  Data Fusion Tool. An example batch script (batsmat.bat) and configuration files (*.cfg) are included in “…\My DataFusion Files\Result\Batchjob”. The script "batch_examples.bat" includes a list of configuration files for the two types of analyses supported by Data Fusion Tool. New configuration files can be added to the batch script to run additional analyses.
[image: ]
[bookmark: _Toc122981788][bookmark: _Toc476654213][bookmark: _Toc112399743]Figure 12. DFT batch script
After editing the Data Fusion Tool batch script, save it and double click on the file to run the analyses.  A Windows command window will display the status of the different Data Fusion Tool analysis runs. Data Fusion Tool will start and run in the background and when the runs are complete, the command window will shut down automatically. The results of the Data Fusion Tool batch runs are output to the “\My DataFusion Files\Result\Batchjob” directory. The *.proj files from these runs can be loaded into the Data Fusion Data Viewer to probe the results from these runs.
Notes:
1. [bookmark: _GoBack]User can “Right-Click  Edit” to view/modify the “batch_examples.bat” file.
1. To run a batch job case, user can add a new line with the same format `start /wait ../../Tool/DataFusion/DataFusion.exe “[Configuration File]”`. 
1. The window batch script will skip the lines which start with “::”. 
[image: ]
[bookmark: _Toc122981789]Figure 13. Example of batch script
1. After editing the batch script, double-click on the script file to begin analysis.
[image: ]
[bookmark: _Toc122981790]Figure 14. Running batch script
1. The output files of a batch job case are also placed under the directory of “My DataFusion Tool\Result\Batchjob\”.
[image: ]
[bookmark: _Toc122981791]Figure 15. Results for Batchjob
Details of the Data Fusion Analysis options are provided in the following Chapters.

PM2.5 Data Fusion Analysis Quick Start
The steps below describe how to use DF to conduct data fusion for PM2.5 with monitor data, model data, and other related data, and verify the data fusion results. For more details, refer to Chapter 4.
Step 1. Click PM menu on the top of Data Fusion Tool Home Page to launch the PM Analysis module window.
[bookmark: _Hlk45310998]Step 2.The Data Input Option window display first. This windows sets the input files of  PM2.5 moritor data , PM2.5 grid model data and other data. Data Fusion Analysis calculates the data fusion result based on the input files.
Use the default settings in the Data Input Option window.
· Click on the Data Input Option hyperlink to display an electronic version of the User’s Manual for this window.
Monitor Data: Sets the input file of PM2.5 monitor data. There are three types of  options: Daily/Weekly Data, Quarterly Data, and Annual Data (The default option is Quarterly Data).
· PM Mass Data: Sets the detailed data of PM2.5 monitor data.
· PM Species: This option is unchecked. (If checked, it will require to input a file of PM2.5 species data).
· Grid Model Data: Sets the data format, base case model data, and grid description file.
· Data Format: Sets the data format of the base year model data. *.csv and IO/API format data are supported.
· Base Case: Sets the detailed data of PM2.5 model data at base year.
· Grid description: There are two grid definition file type options: a CMAQ grid description file and a Grid Shape File(*.shp).
Other Data: This option is unchecked. (If checked, it will require to input a file of Diffusion model file data or Aerosol Optical Depth (AOD) data).
· Click the Next arrow at the bottom right of the Data Input Option window to proceed to the next step.
Step 3. The Data Fusion Technique Option window sets the data fusion algorithms to calculate the data fusion result.
Use the default settings in the Data Input Technique Option window.
· Click on the Data Fusion Technique Option hyperlink to display an electronic version of the User’s Manual for this window.
Algorithm: There are five algorithms options: VNA, eVNA ,Downscaler, wVNA, and Nearest Site. The default choice are VNA, eVNA, and Downscaler.
· Click the Next arrow at the bottom right of the Data Input Technique Option window to proceed to the next step.
Step 4. The Spatial and Temporal Option window customizes the space and time separately to comparing the simulation results of entire domain or partial domain and specified time ranges.
Use the default settings in the Spatial and Temporal Option window.
· Click on the Spatial and Temporal Option hyperlink to display an electronic version of the User’s Manual for this window.
Spatial and Temporal Option: Select Entire Domain or Partial Domain. The Partial Domian sets the grid cells by customizing the starting and ending grid cell in the entire domain.
Temporal Data Fusion Option: Includes the time range of data fusion output results, which are divided into annual average, quarterly average, monthly average, and daily average.
· Click the Next arrow at the bottom right of the Spatial and Temporal Option window to proceed to the next step.
Step 5. The Receptor Option window sets the GIS shape file. This GIS shape file is used to calculate average concentration in specified regions (e.g., states, counties). 
Use the default settings in the Receptor Option window.
· Click on the Receptor Option hyperlink to display an electronic version of the User’s Manual for this window.
· Click the Next arrow at the bottom right of the Receptor Option window to proceed to the next step.
Step 6. The Cross Validation Option window sets cross-validation method to conduct scientific and objective analysis of the validity and stability of data fusion results.
Use the default settings in the Cross Validation Option window.
· Click on the Cross Validation Option hyperlink to display an electronic version of the User’s Manual for this window.
Cross Validation: This option is unchecked. (If checked, it requires to select a kind of cross-validation method).
· Multi-fold: Selects the monitoring data file,groups it, and finally verifies the data fusion result according to the result set synthesized by each group. The result will intuitively show the validity and stability of the data fusion result.
· Leave-one-out: Eliminates different monitoring value points selected by users one by one, compares and analyzes data fusion results in the absence of different monitoring points, and then finds and removes abnormal data values.
· Leave-group-out: Selects the group data sets to compare and analyze data fusion results in the absence of different monitoring points, and then finds and removes abnormal data values.
· Click the Next arrow at the bottom right of the Cross Validation Option window to complete the PM Analysis configuration and run the DF project.
· Click Save & Run Project in the pop-up window. Click Save to create a project (*.proj) file for this tutorial exercise. 
The PM Analysis will complete after a few minutes and the Data Fusion Tool Data Viewer will present the results of this analysis. See Chapter 6 for details on how to use the Data Viewer to analyze the results.

[bookmark: _Toc45225394][bookmark: _Toc122981754]Ozone Data Fusion Analysis Quick Start
[bookmark: _Hlk45311729][bookmark: _Hlk45311714]The steps below describe how to use DF to conduct data fusion operations on Ozone with ozone monitor data, model data and other related data, and verify the data fusion results. For more details, refer to Chapter 5.
Step 1. Click Ozone menu on the top of Data Fusion Tool Home Page to launch the PM Analysis module window.
Step 2. The Data Input Option window display first. This windows sets the input files of Ozone monitor data, grid model data, and other data. Data Fusion Analysis calculates the data fusion result based on the input files.
Use the default settings in the Data Input Option window.
· Click on the Data Input Option hyperlink to display an electronic version of the User’s Manual for this window.
Monitor Data: Set the input file of Ozone monitor data. There are two time-type options:  Annual and Daily (The default option is Annual).
· Selcet Ozone Design Values (DV) Year: Sets the Start Year and End Year corresponding to the monitor data year.
Grid Model Data: Sets the data format, base case model data, and grid description file.
· Data Format: Sets the data format of the base year model data. *.csv and IO/API format data are supported. By default, annual monitor data corresponds to model data in CSV format. Daily monitor data corresponds to model data in IO/API format
· Base Case: Sets the detailed data of Ozone model data at base year.
· Control Case: This option is unchecked. (If checked, it requires to select a file including the detailed data of Ozone model data at control year.)
· Grid description: There are two grid definition filetype options: CMAQ grid description file and Grid Shape File(*.shp).
Other Data: This option is unchecked. (If checked, it requires to input a file of Diffusion model file data or AOD data.)
· Click the Next arrow at the bottom right of the Data Input Option window to proceed to the next step.
Step 3. The Data Fusion Technique Option window sets the data fusion algorithms to calculate the data fusion result.
Use the default settings in the Data Input Technique Option window.
· Click on the Data Fusion Technique Option hyperlink to display an electronic version of the User’s Manual for this window.
Algorithm: There are five algorithm options: VNA, eVNA ,Downscaler, wVNA, and Nearest Site. The default choice are VNA, eVNA, and Downscaler.
· Click the Next arrow at the bottom right of the Data Input Technique Option window to proceed to the next step.
Step 4. The Spatial and Temporal Option window customizes the space and time separately to compare the simulation results of entire domain or partial domain and specified time ranges.
Use the default settings in the Spatial and Temporal Option window.
· Click on the Spatial and Temporal Option hyperlink to display an electronic version of the User’s Manual for this window.
Spatial and Temporal Option: Select Entire Domain or Partial Domain. The Partial Domian sets the grid cells by customizing the starting and ending grid cell in the entire domain.
Temporal Data Fusion Option: Includes the time range of data fusion output results, which are divided into annual average, quarterly average, monthly average, and daily average.
· Click the Next arrow at the bottom right of the Spatial and Temporal Option window to proceed to the next step.
Step 5. The Receptor Option window sets the GIS shape file. This GIS shape file is used to calculate average concentration in specified regions (e.g., states, counties). 
Use the default settings in the Receptor Option window.
· Click on the Receptor Option hyperlink to display an electronic version of the User’s Manual for this window.
· Click the Next arrow at the bottom right of the Receptor Option window to proceed to the next step.
Step 6. The Cross Validation Option window sets cross-validation method to conduct scientific and objective analysis of the validity and stability of data fusion results.
Use the default settings in the Cross Validation Option window.
· Click on the Cross Validation Option hyperlink to display an electronic version of the User’s Manual for this window.
Cross Validation: This option is unchecked. (If checked, it requires to select a kind of cross-validation method).
· Multi-fold: Selects the monitoring data file and groups it, and finally verifies the data fusion result according to the result set synthesized by each group. The result will intuitively show the validity and stability of the data fusion result
· Leave-one-out: Eliminates different monitoring value points selected by users one by one, compares and analyzes data fusion results in the absence of different monitoring points, and then finds and removes abnormal data values.
· Leave-group-out: Selects the group data sets to compare and analyze data fusion results in the absence of different monitoring points, and then find and removes abnormal data values.
· Click the Next arrow at the bottom right of the Cross Validation Option window to complete the Ozone Analysis configuration and run the DF project.
· Click Save & Run Project in the pop-up window. Click Save to create a project (*.proj) file for this tutorial exercise. 

The Ozone Analysis will complete after a few minutes and the Data Fusion Tool Data Viewer will present the results of this analysis. See Chapter 6 for details on how to use the Data Viewer to analyze the results.

[bookmark: _Toc122981755][bookmark: _Functional Framework of Data Fusion]Functional Framework of Data Fusion
Figure 16 shows the functional modules of Data Fusion, including five modules: 
(1) Data input module
(2) Data fusion technique module
(3) Spatial and temporal option module 
(4) Cross validation module
(5) Data viewer module
[image: ]
[bookmark: _Ref44323921][bookmark: _Toc37923801][bookmark: _Toc122981792]Figure 16. The functional framework of Data Fusion
·  Data input module: The Data input module loads the monitor data and the model data to use for the designed data fusion calculations.
·  Data fusion technique module: The Data fusion technique module selects the data fusion methods used for calculations. Five algorithms (VNA, eVNA, DS, wVNA, and NS) are provided in this module, and details of these methods can be found in Appendix I.
· Spatial and temporal option module: The Spatial and temporal option module sets the spatial field and period used for the designed data fusion calculations.
· Cross validation module: The Cross-validation module evaluates the performance of each data fusion technique and analyzes the results at monitor points under the absence of different scenarios. The results are evaluated by the cross-validation methods, including Multi-fold, Leave-one-out, and Leave-group-out methods listed below:
· Multi-fold Cross Validation: Multi-fold cross validation assumes that all monitoring locations are randomly or sequentially divided into K groups across regions. The set of monitors in one group is excluded and then the interpolating algorithm is performed on the remaining monitors. Each algorithm interpolated from the training set is used to make predictions at those excluded monitoring locations. This process is repeated K times, until all groups served as the test set once, thereby creating out-of-sample predictions for all monitoring locations. For example, the program uses a 10-fold CV by default. 10-fold cross validation (10-fold CV) means that all monitoring sites were randomly divided into groups, one of which contains 90% of the sites and the other group contains the remaining 10%. Each algorithm was then applied using data from 90% of the monitoring sites to predict PM2.5 at the remaining 10%. This process was repeated for all groups so that predictions could be evaluated against measurements at all sites. The spatial and temporal correlation (e.g., R2) between predicted PM2.5 and monitored PM2.5 are calculated and showed in the Statistic tab page of the Data Viewer Module.
· Leave-one-out Cross Validation: Leave-one-out is the most extreme case of K-Fold. The training subset is composed of all samples but one, which is used for validation. The procedure is also repeated K times.
· Leave-group-out Cross Validation: Leave-group-out is a clustered cross-validation approach, which splits the points by space used a k-means algorithm. This approach is an unsupervised learning technique requiring a pre-specified number of clusters based on proximity to the nearest mean (defined spatially), effectively grouping points into Voronoi polygons given by those means. The distance metric used to define space is the conventional Euclidean distance. Cross-validation groups are contained within regions under this approach, with a predetermined number of pf clusters per region based on the selected Radius of Selected Monitors Withheld.


[bookmark: _Start_new_analyses][bookmark: _PM2.5_data_fusion][bookmark: _Toc122981756]PM2.5 Data Fusion Analysis Details
Details of the PM2.5 Analysis options in the DF are provided in this Chapter. A default project is used to demonstrate the options for this data fusion analysis.
The PM2.5 data fusion analysis in DF is organized into five steps. The steps include the data input and configuration options for interpolation. The following configuration steps correspond to different DF windows are described in detail in this chapter:
· Data Input Option: Specify related data needed to be interpolated in the DF, including the monitor data, species monitor data, model data, and other data.
· Data Fusion Technique Option: Select those algorithms of interest. It is also supported to select multiple algorithms at a time.
· Spatial and Temporal Option: Customize the selection of spatial and temporal for analysis of the model data.
· Receptor Option: Select the corresponding GIS shapefile to calculate the aggregation average concentration of pollutants from Grid to region (e.g., state, county, city) level.
· Cross Validation Option: Select cross validation methods to validate the data fusion results and analyze the results at monitor points under the absence of different scenarios.
To conduct a PM2.5 analysis, click the PM menu from the main menu on the DF Home Page. Figure 17 shows the initial window for PM Analysis. The box in the upper left of the window (highlighted in red in Figure 17) lists the configuration steps of the PM Analysis. Each step listed in this box has a different set of configuration options for PM Analysis. Once a step is successfully configured, the yellow buttons in the box will change from yellow to green. In general, the configuration steps must be followed in order, from top to bottom, as they are listed in the box. Previously completed steps may be accessed and modified by double-clicking on the step name in the box. Once the configuration for a step is complete, users can move to the next step by either clicking on it or by selecting the Next button (shown in the blue box in Figure 17).
A previous project can be loaded by clicking the Open button in the File drop-down menu item, and a new project may be initiated at any time in the PM Analysis window by clicking PM menu on the top of DF start page or selecting New Project button from the File drop-down menu item. 
Each of the PM Analysis configuration steps is described in the following sections.
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[bookmark: _Ref512333087][bookmark: _Toc122981793][bookmark: _Toc37923805]Figure 17. Start Page of Creating new PM2.5 data fusion
[bookmark: _Data_Input_Option][bookmark: _Toc122981757]Data Input Option
Data Input Option is the first step in PM2.5 data fusion configuration options. The interface is shown in Figure 18, including configuration options listed below:
·  Project Name: Text string to identify this analysis and set the name of the project file.
·  Monitor Data: DF requires monitoring data in the form of a text file. DF uses both "Quarterly Data" and "Daily/Weekly Data," as well as PM2.5 species data in its calculations.
Quarterly Data. The EPA-approved quarterly average PM2.5 FRM data that have been used to calculate PM2.5 design values. These data are commonly used in the attainment test tool (e.g., SMAT-CE). The default data file in DF was created by EPA OAQPS. In most cases, the data should not be altered, however, in some cases (e.g. sensitivity analysis) there may be a need to add or remove data.
Daily/Weekly Data. PM2.5 data that are needed to calculate species fractions. These data are used in combination with the Species Monitor Data File. 
A detailed description of the formats of the input data files used in this step is available in Section 2.4 of the User’s Manual of SMAT-CE.
· Grid Model Data: These are gridded model output from models such as CMAQ or CAMx. Users can choose either daily model data input or quarterly model data input (which is just a quarterly average of the daily model data). Either will work for the PM2.5 Analysis. The default setting is daily average data. It supports two kinds of formats: one is the simple comma-separated text format (*.csv) and the other is IOAPI format. Note that the model data year should be consistent with the base year of monitor data. 
· Other Data: Other data mainly include dispersion model data, related geographic information data, and AOD data. AOD data is mainly used for satellite data fusion. Users can choose according to their requirements. The program does not use it by default.
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[bookmark: _Ref512344957][bookmark: _Toc37923806][bookmark: _Toc122981794]Figure 18. Data Input Option (PM2.5)
Users can keep default options and configuration, or change options and configuration according to their requirements. After setting all the options, click the Next button or double-click the node of Data Fusion Technique Option in the upper left corner to proceed to the next step. The color of this node icon changes from yellow to green, indicating that this step is ready.
[bookmark: _Data_Fusion_Technique][bookmark: _Ref523235068][bookmark: _Toc122981758][bookmark: _Toc438541484][bookmark: _Toc439061773]Data Fusion Technique Option
Data Fusion Technique Option includes five data fusion algorithms. Users can choose one or more algorithms of interest to calculate at a time. The interface is shown in Figure 19, including five algorithms of VNA, eVNA, DS, wVNA, and NS. The preferred default choices are VNA, eVNA, and Downscaler. The calculation principle of these five algorithms are described in Appendix I.
· Users can check the Advanced options under the eVNA algorithm option to set the Inverse Distance Weighting Power (the default is 2) and the Gradient-adjusted threshold (GAT, the default is 3), as shown in Figure 20. Inverse Distance Weighting Power means that the value is the sum of the coefficient of the distance from the monitor point to the interpolation point. Gradient-adjusted threshold means that the value in the model grid cell will be replaced with the threshold value (= GAT × CMonitor) if the ratio of modeled concentration to monitored concentration in a target grid cell is larger than the Gradient-adjusted threshold.
· Users can check the Advanced options under the Downscaler algorithm option to set the number of iterations and related parameters to reduce the computational load, and improve the calculation effectiveness, as shown in Figure 21.
· Users can check the Advanced options under the wVNA algorithm option to set the value of weight between VNA and eVNA, as shown in Figure 22.
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[bookmark: _Ref512347066][bookmark: _Toc37923807][bookmark: _Toc122981795]Figure 19. Data Fusion Technique Option (PM2.5)
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[bookmark: _Ref512348906][bookmark: _Toc122981796][bookmark: _Toc37923808]Figure 20.  Advanced Option in eVNA (PM2.5)
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[bookmark: _Ref512348922][bookmark: _Toc37923809][bookmark: _Toc122981797]Figure 21.  Advanced Option in Downscaler (PM2.5)
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[bookmark: _Ref522868753][bookmark: _Toc37923810][bookmark: _Toc122981798]Figure 22.  Advanced Option in wVNA (PM2.5)
The default configuration is that the VNA, eVNA, and Downscaler algorithm options are selected. Users can keep default options and configuration, or change options and configuration according to their requirements. After setting all the options, click the Next button or double-click the node of Spatial and Temporal Option in the upper left corner to proceed to the next step. The color of this node icon changes from yellow to green, indicating that this step is ready.
[bookmark: _Toc122981759]Spatial and Temporal Option
The interface of Spatial and Temporal Option is shown in Figure 23, including Spatial Data Fusion Option and Temporal Data Fusion Option. Users can specify the spatial and temporal options.
· Spatial Data Fusion Option: Set the number of the model grid cells used in the calculations to interpolate from the monitor data, including the Entire Domain and customized Partial Domain. For the Entire Domain, DF will output the results for all specified monitors within the domain. For the Partial Domain, DF will create a spatial filed that matches the size of the gridded model domain according to the Starting Grid Cell and Ending Grid Cell.
·  Temporal Data Fusion Option: Set the period used in the calculations to interpolate from the monitor data. It is divided into the Annual Average, Quarterly Average, Monthly Average, and Daily Average. 
When selecting the Daily/Weekly Data option at the step of Data Input Option (Chapter 4.1), all options of Temporal Data Fusion Option will be available. When selecting the Quarterly Data option at the step of Data Input Option, Monthly Average and Daily Average will be unavailable. When selecting the Annual Data option at the step of Data Input Option, only the Annual Average will be available and other options will be greyed out.
DF will calculate the Annual Average, Quarterly Average, Monthly Average, and Daily Average from the input DF formatted daily average gridded model files or quarterly average files and optionally output the annual, quarterly, monthly, and daily average concentrations into text files (CSV files) respectively.
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[bookmark: _Ref512349259][bookmark: _Toc122981799][bookmark: _Toc37923811]Figure 23. Spatial and Temporal Option (PM2.5)
Users can keep default options and configuration, or change options and configuration according to their requirements. After setting all the options, click the Next button or double-click the node of Receptor Option in the upper left corner to proceed to the next step. The color of this node icon changes from yellow to green, indicating that this step is ready.
[bookmark: _Receptor_Option][bookmark: _Ref523235152][bookmark: _Toc122981760]Receptor Option
The interface of Receptor Option is shown in Figure 24, including Use Model Grid and Use GIS Shape File options.
·  Use Model Grid: The model grid file in the area of data fusion (checked in default).
·  Use GIS Shape File: The average concentration of pollutants in each region, which can be aggregated by selecting the GIS-related file of the analysis area in the interface of Receptor Option. The format of the input file can be either *.shp or *.csv.
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[bookmark: _Ref512351243][bookmark: _Toc37923812][bookmark: _Toc122981800]Figure 24. Receptor Option (PM2.5)
Users can keep default options and configuration, or change options and configuration according to their requirements. After setting all the options, click the Next button or double-click the node of Cross Validation Option in the upper left corner to proceed to the next step. The color of this node icon changes from yellow to green, indicating that this step is ready.
[bookmark: _Cross_Validation_Option][bookmark: _Ref523235201][bookmark: _Toc122981761]Cross Validation Option
The data fusion results can be evaluated by the following three cross-validation methods: Multi-fold, Leave-one-out, and Leave-group-out methods (Figure 25). Users can select a method of interest at a time. Users can also set a Radius of Selected Monitors Withheld to implement the Cluster analysis for leaving-out the cluster of monitors within a specific radius of selected monitors. The calculation principle of these five algorithms is described in Appendix I.
·  Under the Multi-fold cross validation option (checked in default), users can set the number of groups and grouping types (Random and Sequential (Cluster)), as shown in Figure 25. Random means all monitor sites are randomly divided into specified groups, while Sequential means all monitor sites are grouped by the order of monitors. Users can also set the Radius of Selected Monitors Withheld to implement a radius of withholding for the random & sequential Multi-Fold cross validation. The Radius of Selected Monitors Withheld means to remove nearby clusters/monitors with radius withheld at a time. For example, the radius = 0 km means just removing selected monitor only at a time, while radius = 1 km means removing a cluster of monitors within 1km for each selected monitor.
·  Under the leave-one-out cross validation option, users can select the monitor sites to leave out by importing it into the right panel, as shown in Figure 26. The option means that a single monitor or nearby cluster/monitors within the radius will be removed from the selected monitors at a time. 
·  Under the leave-group-out cross validation option, users can select the group data sets to be verified and import it into the right panel, as shown in Figure 27. Users can also set the Radius of Selected Monitors Withheld to leave a group of individual monitors and nearby clusters/monitors with radius withheld at the same time.
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[bookmark: _Ref512352752][bookmark: _Toc37923813][bookmark: _Toc122981801]Figure 25. Cross Validation Option (PM2.5)
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[bookmark: _Ref512361739][bookmark: _Toc37923814][bookmark: _Toc122981802]Figure 26. Leave-one-out Cross Validation
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[bookmark: _Ref522872871][bookmark: _Toc122981803][bookmark: _Toc37923815]Figure 27. Leave-group-out Cross Validation
Users can keep default options and configuration, or change options and configuration according to their requirements. After completing this step, all configuration options for creating new PM2.5 data fusion have been completed. Click the Next button to Save Project, or Save & Run Project, as shown in Figure 28. Users can also click the Save Project & Run or Save Project button at the left bottom of the interface to save the project.
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[bookmark: _Ref512362269][bookmark: _Toc122981804][bookmark: _Toc37923816]Figure 28. Save & Run Project
[bookmark: _Ozone_data_fusion][bookmark: _Aerosol_Optical_Depth][bookmark: _Toc122981762]Ozone Data Fusion Analysis Details
Details of the Ozone Analysis options in the DF are provided in this Chapter. A default project is used to demonstrate the options for this data fusion analysis.
The steps of creating new Ozone data fusion analysis are similar to the steps of creating new PM2.5 data fusion analysis.
To conduct an Ozone analysis, click the Ozone menu from the main menu on the DF Start Page. Figure 29 shows the initial window that is displayed when the Ozone Analysis is selected. The box in the upper left of the window (highlighted in red in Figure 29) lists the configuration steps of the Ozone Analysis. Each step listed in this box has a different set of configuration options that are displayed in the Ozone Analysis window. Once each step is successfully configured, the yellow buttons in the box will change from yellow to green. In general, the configuration steps must be followed in order, from top to bottom, as they are listed in the box. Previously completed steps may be accessed and modified by double-clicking on the step name in the box. Once the configuration for a step is complete, users can move to the next step by either clicking on it or by selecting the Next button (shown in the blue box in Figure 29). 
A previous project can be loaded by clicking the Open button in the File drop-down menu item, and a new project may be initiated at any time in the Ozone Analysis window by selecting Ozone menu on the top of the DF start page or clicking the New Project button from the File drop-down menu.
Each of the Ozone Analysis configuration steps is described in the following sections.
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[bookmark: _Ref512363147][bookmark: _Toc37923825][bookmark: _Toc122981805]Figure 29. Start Page of Creating new Ozone data fusion
[bookmark: _Toc122981763]Data Input Option
Data Input Option is the first step in Ozone data fusion configuration options. The interface is shown in Figure 30, including configuration options listed below:
·  Project Name: Text string to identify this analysis and set the name of the project file.
·  Monitor Data: DF requires monitoring data in the form of a text file. DF uses both "Annual" Data and "Daily" Data in its calculations. The start and end years should be changed to applicable periods, depending on the base modeling year. Users can set the additional Advanced Option to specify the area of grid cells used in calculations.
·  Grid Model Data: These are gridded model output from models such as CMAQ or CAMx. Users can choose either daily model data input or annual model data input (which is just an annual average of the daily model data). Either will work for the Ozone Analysis. The default setting is the annual average data. It supports two kinds of formats: one is the comma-separated values format (*.csv) and the other is IOAPI format. The model value and the monitor value can be matched automatically according to the selected daily monitor data, as shown in Figure 31.
·  Other Data: Other data mainly include dispersion data and related geographic information data. Users can choose according to their requirements. The program does not use it by default.
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[bookmark: _Ref512363716][bookmark: _Toc37923826][bookmark: _Toc122981806]Figure 30. Data Input Option (Ozone)
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[bookmark: _Ref512364714][bookmark: _Toc37923827][bookmark: _Toc122981807]Figure 31. Variable Mapping (Ozone)
Users can keep default options and configuration, or change options and configuration according to their requirements. After setting all the options, click the Next button or double-click the node of Data Fusion Technique Option in the upper left corner to proceed to the next step. The color of this node icon changes from yellow to green, indicating that this step is ready.
[bookmark: _Toc122981764]Data Fusion Technique Option
The interface design of the Data Fusion Technique Option for Ozone data fusion analysis is similar to that of PM2.5 data fusion analysis, as shown in Figure 32. The preferred default choices are VNA, eVNA, and Downscaler. Users can refer to Chapter 4.2 above.
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[bookmark: _Ref512365671][bookmark: _Toc37923828][bookmark: _Toc122981808]Figure 32. Data Fusion Technique Option (Ozone)
Users can keep default options and configuration, or change options and configuration according to their requirements. After setting all the options, click the Next button or double-click the node of Spatial and Temporal Option in the upper lefthand corner to proceed to the next step. The color of this node icon changes from yellow to green, indicating that this step is ready.
[bookmark: _Toc122981765]Spatial and Temporal Option
The interface of Ozone Spatial and Temporal Option is shown in Figure 33, including Spatial Data Fusion Option and Temporal Data Fusion Option. Users can specify the spatial and temporal options.
·  Spatial Data Fusion Option: Set the number of model grid cells used in the calculations to interpolate from the monitor data, including the Entire Domain and customized Partial Domain. For the Entire Domain, DF will output the results for all specified monitors within the domain. For the Partial Domain, DF will create a spatial filed that matches the size of the gridded model domain according to the Starting Grid Cell and Ending Grid Cell.
·  Temporal Data Fusion Option: Set the period to use in the calculations to interpolate from the monitor data. It is divided into the Annual Average, Quarterly Average, Monthly Average, and Daily Average. Note that the Annual Average option for Ozone data fusion analysis is not available for annual average calculations based on quarterly values, as shown in Figure 34.
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[bookmark: _Ref522888459][bookmark: _Toc122981809][bookmark: _Toc37923829]Figure 33. Spatial and Temporal Option (Ozone)
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[bookmark: _Ref512366089][bookmark: _Toc37923830][bookmark: _Toc122981810]Figure 34. Spatial and Temporal Option - Only Annual Average (Ozone)
Users can keep default options and configuration, or change options and configuration according to their requirements. After setting all the options, click the Next button or double-click the node of Receptor Option in the upper left corner to proceed to the next step. The color of this node icon changes from yellow to green, indicating that this step is ready.
[bookmark: _Toc122981766]Receptor Option
The interface design of Receptor Option for Ozone data fusion analysis is similar to that of PM2.5 data fusion analysis, as shown in Figure 35. Users can refer to Chapter 4.4.
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[bookmark: _Ref512367602][bookmark: _Toc37923831][bookmark: _Toc122981811]Figure 35. Receptor Option (Ozone)
Users can keep default options and configuration, or change options and configuration according to their requirements. After setting all the options, click the Next button or double-click the node of Cross Validation Option in the upper left corner to proceed to the next step. The color of this node icon changes from yellow to green, indicating that this step has been successfully completed.
[bookmark: _Toc122981767]Cross Validation Option
The interface design of Cross Validation Option for Ozone data fusion analysis is similar to that of PM2.5 data fusion analysis (except that the functions of Leave-group-out and cluster analysis are still under development), as shown in Figure 36. Users can refer to Chapter 4.5.
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[bookmark: _Ref512367894][bookmark: _Toc37923832][bookmark: _Toc122981812]Figure 36. Cross Validation Option (Ozone)
Users can keep default options and configuration, or change options and configuration, according to their requirements. After completing this step and all the configuration options for creating new Ozone data fusion have been completed, the steps of Save & Run Project are the same as that of saving PM2.5 data fusion results.
[bookmark: _Data_Viewer_for][bookmark: _Toc122981768]Data Viewer for analyzing results
The main function of the Data Viewer module is to display the data fusion results in multiple ways. The Data Viewer module can be loaded in the following ways:
·  Click the File drop-down menu to open an existing project, then the interface of the Data Viewer of this project will be exhibited automatically.
·  Click the Data Viewer menu item to enter the Data Viewer interface directly, then click the Project button at the bottom left to open the related project.
·  Select Save & Run Project after creating a new PM2.5 or Ozone data fusion analysis, then the data viewer interface of the project will be loaded automatically after the run.
The interface of the Data Viewer module is mainly divided into two parts: the Output File area and the Data Viewer area, as shown in Figure 37. The left-hand pane of the interface is the output files area, listing the output files created during the configuration of the DF analysis. Which types of output files are available is dependent on the type of analysis (PM2.5, Ozone) and the output choices set in the Configuration File. Clicking on any of the output files will load the data into the graphical and tabular analysis module of Data Viewer. The right-hand pane of the interface is the data viewer area, displaying the data fusion analysis results of the example testing case.
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[bookmark: _Ref512412219][bookmark: _Toc122981813][bookmark: _Toc37923833]Figure 37. The interface of the Data Viewer
The results can be displayed in the following ways:
·  Map Viewer: Spatial tile plots of model output data used for estimating relative response factors.
·  GIS Viewer: Open-source geographic information system (GIS) graphical interface for displaying point analysis results of the DF at monitor locations. Multiple data layers can be added to the map and different attributes within each layer can be plotting in the GIS tab.
·  Statistics Viewer: Display of the DF input and output data through the bar chart.
·  Data Viewer: Display of the DF input and output data through the table.
·  Log/Msg Viewer: Logging information generated during the currently loaded project.
[bookmark: _Toc122981769]Map Viewer
The Map Viewer window displays the outcomes of model results at monitor locations in the modeling domain. Example results available to view in the Map window include the spatial and temporal data fusion results interpolated by the algorithms used in the calculations. The configuration options available in the Map window include zooming in/out of the map; clicking on a monitoring site in the modeling domain to view the site information; specifying the color legend; checking to display the location and concentration of monitor sites; selecting background areas; using the formula function developed for common mathematical calculations between different data fusion results; and saving the results as an image or CSV file. The interface of the Map for PM2.5 or Ozone is shown in Figure 38 and the interface of the Map for AOD are shown in Figure 39.
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[bookmark: _Ref512415515][bookmark: _Toc37923834][bookmark: _Toc122981814]Figure 38. The interface of the Map Viewer (PM2.5 or Ozone)
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[bookmark: _Ref35855073][bookmark: _Toc37923835][bookmark: _Toc122981815]Figure 39. The interface of the Map Viewer (AOD)
·  To examine the results from a completed DF analysis, select one of the algorithms in the left-hand pane of the Data Viewer window to display the resulting data on the DF map for analysis (Figure 40); select one of the periods in the Filter drop-down boxes and one of the pollutants in the Variable drop-down boxes for analysis (the default case calculates the average value for PM2.5 only, the cases for analysis of other variables within different periods can perform this operation); select one of the output files in the Output Files pane to show the file data on the map for analysis (the default case contains only one output file, the analysis cases with multiple output files can perform this operation). Click the Apply button to display the selected analysis choices on the Map of the DF.
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[bookmark: _Ref512416866][bookmark: _Toc37923836][bookmark: _Toc122981816]Figure 40. Show map of selected algorithms
·  As shown in Figure 41, this option adjusts the map legend levels. Double-click the color bar on the right-hand of the map to display the legend controls. The legend controls can set the minimum and maximum values of the legend and the individual colors on the scale, as is shown in Figure 42.
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[bookmark: _Ref512417724][bookmark: _Toc37923837][bookmark: _Toc122981817]Figure 41. Double click to change legend
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[bookmark: _Ref512417923][bookmark: _Toc122981818][bookmark: _Toc37923838]Figure 42. Configure Plot
·  As shown in Figure 43 and Figure 44, these options control zooming in/out, exporting the map image, and overlaying monitor data on the map image.
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[bookmark: _Ref512418605][bookmark: _Toc37923839][bookmark: _Toc122981819]Figure 43. Click the Plot menu item to manage map
[image: ]
[bookmark: _Ref512418744][bookmark: _Toc37923840][bookmark: _Toc122981820]Figure 44. Right-click the map
·  As shown in Figure 45, this option controls the monitors on the DF map, the program checks show monitors here in default.
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[bookmark: _Ref512419363][bookmark: _Toc37923841][bookmark: _Toc122981821]Figure 45. Show Monitors
·  As shown in Figure 46, the site information (location, latitude, longitude, country name, etc.) can be viewed by double-clicking on the monitor location on the map of the DF.
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[bookmark: _Ref523248337][bookmark: _Toc37923842][bookmark: _Toc122981822]Figure 46. Show site information
·  As shown in Figure 47, this option is developed for the common mathematical calculations between multiple data fusion results through the formula function.
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[bookmark: _Ref512419814][bookmark: _Toc37923843][bookmark: _Toc122981823]Figure 47. Formula Editor
·  Click the Window menu item with the blue font above the DF Map Viewer window, then choose Close to close the window.
[bookmark: _Toc122981770]GIS Viewer
The GIS window displays the fused results in the selected modeling domain with GIS layer. The configuration options available in the Map window include (1)Zoom in/out on the map; (2)Move the domain with hand icon [image: ]; (3)Show full extent for current dowmain by clicking the global icon [image: ];(4) View the fused results in a selected grid cell or receptor by clicking identify icon [image: ] (5) Save layer files and append new layer files; (6)Display the aggregation average concentration of the selected modeling domain in the receptor regions. The interface of the DF GIS Viewer is shown in Figure 48.
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[bookmark: _Ref512447110][bookmark: _Toc37923844][bookmark: _Toc122981824]Figure 48. The interface of the GIS Viewer
·  To examine the results from a completed DF analysis, select one of the algorithms in the left-hand pane of the Data Viewer window to display the result data on the DF GIS for analysis; select one of the periods in the Filter drop-down boxes and one of the pollutants in the Variable drop-down boxes for analysis (the default case calculates the average value for PM2.5 only, the cases for analysis of other variables within different periods can implement this operation); select one of the output files in the Output Files pane to show the file data on the GIS for analysis (the default case contains only one output file, the analysis cases with multiple output files can implement this operation). Click the Apply button to display the selected analysis choices through GIS on the DF.
·  The GIS Viewer shows the aggregation average concentration of the selected modeling domain in default, as shown in Figure 48. Unchecking the Show Receptor can show the spatial distribution of the pollutants, as shown in Figure 49.
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[bookmark: _Ref512448367][bookmark: _Toc37923845][bookmark: _Toc122981825]Figure 49. GIS Viewer (spatial distribution of pollutants)
·  As shown in Figure 50, this option provides a quick adjustment of the GIS map legend levels. Double-click the color bar to display the legend controls, as shown in Figure 51. The legend controls can set the minimum and maximum values of the legend and the individual colors on the scale. More detailed customization of the legend of the map is available by double-clicking a map layer in the Layer Controls section of the GIS window.
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[bookmark: _Ref512449110][bookmark: _Toc37923846][bookmark: _Toc122981826]Figure 50. Double click to change legend
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[bookmark: _Ref512449241][bookmark: _Toc122981827][bookmark: _Toc37923847]Figure 51. Set Value Range
· As shown in Figure 52 and Figure 53, these options control zooming in/out and panning the map display, probing monitor values, exporting the map image, saving a shapefile of the results, and adding external shapefile data to the GIS map.
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[bookmark: _Ref512449600][bookmark: _Toc122981828][bookmark: _Toc37923848]Figure 52. Click shortcut key to change the GIS map configurations
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[bookmark: _Ref512449756][bookmark: _Toc122981829][bookmark: _Toc37923849]Figure 53. Right-click to save the GIS Layer
· As shown in the red box in Figure 54, these options control the layer attributes of the DF result to display on the map, the ability to quickly zoom to selected sub-regions (Zoom To) and the boundary layer attributes to display on the map (Domain Selections). The Map Layers section of this area can display different GIS layers, and right-clicking on any of the layers to provide advanced configuration controls for the layer.
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[bookmark: _Ref512451487][bookmark: _Toc122981830][bookmark: _Toc37923850]Figure 54. Options of showing different GIS layers
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[bookmark: _Ref512451473][bookmark: _Toc122981831][bookmark: _Toc37923851]Figure 55. Show GIS layers of different regions
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[bookmark: _Ref512451500][bookmark: _Toc37923852][bookmark: _Toc122981832]Figure 56. Show GIS layers of different algorithms
[bookmark: _Toc122981771]Chart Viewer
The Chart window displays the DF input and output data as a scatter plot. This type of display is useful for comparing data fusion results interpolated by different algorithms. The Chart view will display the analysis results as a scatter plot on the right-hand panel of the Data Viewer window (Figure 57).
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[bookmark: _Ref512452666][bookmark: _Toc122981833][bookmark: _Toc37923853]Figure 57. The interface of the Chart Viewer
· To validate the results from a completed DF analysis, select one of the algorithms in the left-hand pane of the Data Viewer window to display the result data on the DF Chart for analysis (Figure 58). Select one of the periods in the Filter drop-down boxes and one of the pollutants in the Variable drop-down boxes for analysis (the default case calculates the average value for PM2.5 only, the cases for analysis of other variables within different periods can perform this operation). Select one of the output files in the Output Files pane to show the file data on the Chart for analysis (Figure 59). Click the Apply button to display the selected analysis choices through Chart on the DF.
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[bookmark: _Ref512453319][bookmark: _Toc122981834][bookmark: _Toc37923854]Figure 58. Show chart of selected algorithms
[image: ]
[bookmark: _Ref512453586][bookmark: _Toc37923855][bookmark: _Toc122981835]Figure 59. Show chart of different output files
·  As shown in Figure 60, right-clicking on the chart will display a selection box with options to Copy the chart to the clipboard, export (Save Image As) an image of the chart, print the chart, and zoom out (Un-Zoom) from the chart. The Show Point Values right-click option enables the values of a monitor to be displayed when the mouse hovers over the monitor. The Change Title and Legend right-click option enables customization of the variable names, title, and axes, as shown in Figure 61.
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[bookmark: _Ref512454076][bookmark: _Toc37923856][bookmark: _Toc122981836]Figure 60. Right-click the chart
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[bookmark: _Ref512454084][bookmark: _Toc37923857][bookmark: _Toc122981837]Figure 61. Change Title and Legend
·  As shown in Figure 62, click the Bias Table menu item with the blue font above the DF Chart viewer interface can display the estimated performance of data fusion results interpolated by the selected algorithms. Click the Save data button at the bottom right can export the data to a CSV file.
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[bookmark: _Ref512454866][bookmark: _Toc122981838][bookmark: _Toc37923858]Figure 62. Show Bias Table
·  Click the Window menu item with the blue font above the DF Chart Viewer window, then choose Close to close the window.
[bookmark: _Toc122981772]Result Data Viewer
The Result Data window displays the DF input and output data in a tabulated format. The Data view will display the analysis results as a table on the right-hand panel of the Data Viewer window (Figure 63).
[image: ]
[bookmark: _Ref512516786][bookmark: _Toc37923859][bookmark: _Toc122981839]Figure 63. The interface of the Result Data Viewer
·  To plot the results from a completed DF analysis, select one of the algorithms in the left-hand pane of the Data window to display the result data table on the DF Data for analysis. Select one of the periods in the Filter drop-down boxes and one of the pollutants in the Variable drop-down boxes for analysis (the default case calculates the average value for PM2.5 only, the cases for analysis of other variables within different periods can implement this operation). Select one of the project output files in the Output Files pane to show the file data on the Data for analysis (Figure 64). Click the Apply button to display the selected analysis choices on the Data table of the DF.
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[bookmark: _Ref512517071][bookmark: _Toc37923860][bookmark: _Toc122981840]Figure 64. Show result data of different output files
·  As shown in Figure 65, the list shows the output files generated in the calculations of data fusion and the relative columns in the data table. Checking the boxes next to the columns and clicking "Apply" will filter out rows in the table where the values of the selected column(s) are null (-9). The data table shows the tabulated results from the selected DF data file. The table can be sorted by any of the columns by left-clicking on the column header.
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[bookmark: _Ref512517492][bookmark: _Toc37923861][bookmark: _Toc122981841]Figure 65. Show data detail of checked column
·  As shown in Figure 66, this option of the data window sets the precision of the values in the table (we set it to 6 here).
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[bookmark: _Ref512517811][bookmark: _Toc122981842][bookmark: _Toc37923862]Figure 66. Set the digits after decimal point
[bookmark: _Toc122981773]Log/Msg Viewer
The DF Log/Mag Viewer window displays the logging information generated during the currently loaded project. Clicking on the Log & Msg menu item displays the steps used to create the DF results and the time that the run completed (Figure 67).
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[bookmark: _Ref512518621][bookmark: _Toc37923863][bookmark: _Toc122981843]Figure 67. The interface of the Log/Msg Viewer
This Chapter describes the multiple display forms under the Data Viewer module in the Data Fusion tool. The interface design and operation methods of the Data Viewer module for PM2.5 are similar to that for Ozone.
[bookmark: _Ref525033829][bookmark: _Toc122981774]Appendix I
[bookmark: _Toc525328121][bookmark: _Toc122981775]Evaluation principle of Data Fusion Techniques
1. Voronoi Neighbor Averaging (VNA): It is a deterministic spatial interpolation method that calculates the concentration at the center of each grid cell as the inverse-distance-squared weighted average of PM2.5 concentrations at neighboring monitors, where the neighboring monitors are identified using Delaunay triangulation. The equation is shown below:
	 
	(1)



where: n is the number of neighboring sites, Weighti is the inverse distance squared weight for monitor i, Monitori is the observed concentration at monitor i, and VNA(E) is the estimation at grid cell E.
2. Enhanced Voronoi Neighbor Averaging (eVNA): In the eVNA approach, the monitored concentrations used in VNA interpolation are multiplied by the ratio of the modeled concentration in the target grid cell to that in the monitor-containing grid cell. Therefore, eVNA places strong weight on CMAQ gradients between the target cell and cells with nearby monitors. The equation of eVNA is defined as:
	 
	(2)


where: ModelE is the modeled concentration for cell E, and Modeli is the modeled concentration in the grid cell containing monitor site i. 
3. Downscaler (DS): The DS interpolation method is a relatively complex statistical prediction method, but DS resembles a simple linear regression model with spatially varying coefficients at a high level. DS uses Markov chain Monte Carlo (MCMC) methods with Gibbs sampling to develop a relationship between observed and modeled concentrations, and then use the relationship to predict concentrations at points in the spatial domain. The DS method is frequently used to develop exposure fields for health studies.
The general structure of DS can be expressed in an equation similar to that of linear regression: 
	  
	(3)


where: 
 is the observed monitoring station data at location s on day t. Furthermore, let  be the CMAQ output for grid block Bk on day t. 
 is a mean zero Gaussian process with covariance function,
	,  
	(4)


the predictors  are defined as, 
	  
	(5)


with
	  
	(6)


K is the total number of numerical model grid cells,  is a decay parameter, ck is the centroid for the kth grid cell, and Qt(s) is a mean zero Gaussian process with covariance function  which is defined similarly to (4). In this way  defines the multiplicative increase to the spatial weight given by .
 is a white noise Gaussian process with variance . 
The various parameters of DS and how the estimation of these parameters are described below: 
1. (,,). Vague conjugate prior distributions are assumed for these parameters. Additionally,  and  are assumed to be independent in time. Thus, conditional on , (,,) can be sampled via composition by first sampling  then sampling  conditional on the obtained value of .
2. . The prior distribution for , as stated above, is a mean zero Gaussian process with exponential covariance function and decay parameter . Conditional on all the parameters, the entire vector of  can be sampled from its Gaussian complete conditional distribution.
3. . Using the conjugate inverse gamma distribution,  can be drawn directly from its complete conditional distribution.
4. . This parameter represents the rate of decay of the spatial correlation in . Specifically, as  increases, the spatial correlation of  decreases. Since decay parameters for the spatial process are particularly difficult to estimate1, a grid search for the spatial range with discrete prior which places mass at (10; 20;  ; 90) percent of the maximum observed distance between  and  is used. After performing the grid search,  is fixed at the most likely value (from the grid search) for the remainder of the MCMC algorithm.
5. . These parameters represent the decay parameters for the weights  used to weight various neighboring numerical model grid cell observations. As very little information about these parameters is available2 , and  are fixed such that the weights (correlation) are essentially zero beyond a distance of three grid cells.
6. . Each  defines a multiplicative increase in the weight assigned to the numerical model value . Intuitively, if  is large then  will have a large effect on . Notice that there is one  for each CMAQ centroid. This represents, potentially, a very large number of . As such, predictive process3 are used to reduce the dimensionality. Specifically,  where the {bj} are a set of sparsely chosen locations with the number of bj being substantially less than the number of ck. In this way, all  can be updated by updating relatively few . To update , a Metropolis-Hastings step is used with proposal distribution equal to the prior distribution.
4. Weighting Voronoi Neighbor Averaging (wVNA): The wVNA interpolation method combines the VNA and eVNA methods by setting the weights of VNA and eVNA.
	  
	(7)


where:
w is the weight coefficient, when   = 0,   = , when   = 1,   = .
5. Nearest Site (NS): The Nearest Site interpolation method is a deterministic spatial interpolation method that chooses the single closest monitor and applies that value as the grid cell value. 
	  
	(8)


where:
the nearest monitor s species/PM2.5 concentration to cell E, = modeled species/PM2.5 concentration at cell E.
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